PS and PL communication using AXI DMA
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This document will walk you through

1. Understand what DMA is and why it is important for FPGA

2. How to transfer data between PS and PL using DMA with the correct components from the
FPGA

3. How to exploit the above DMA feature in software (using the C programming language)

Overview: What is DMA and why we should use it for FPGA

In this design, we’ll use the DMA to transfer data from memory to an IP block and back to the
memory. In principle, the IP block could be any kind of data producer/consumer such as the HDR-NN
hardware implement or just a matrix multiplier, but in this tutorial, we will use a simple FIFO to
create a loopback. After, you’ll be able to break the loop and insert whatever custom IP you like.

//TODO: think about what you want to implement in the PL side. You can implement the whole
HDR-NN using Verilog and invoke it from the C. Or you can implement your HDR-NN in software and
ship part of the functionalities to PL.

Application processor unit

(APU) -

PS

PL

sng |euJajul

AXI_S2MM AXIS_MM2S

DDR

Memory AXI DMA AXI FIFO
Controller

AXI_MM?2S AXIS_MM2S

The block diagram above illustrates the design that we’ll create. The processor and DDR memory
controller are contained within the Zyng PS. The AXI DMA and AXI Data FIFO are implemented in the
Zyng PL. The AXI-lite bus allows the processor to communicate with the AXI DMA to setup, initiate
and monitor data transfers. The AXI_MM2S and AXI_S2MM are memory mapped AXI4 buses and
provide the DMA access to the DDR memory. The AXIS_MM2S and AXIS_S2MM are AXIl4-streaming
buses, which source and sink a continuous stream of data, without addresses.
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Notes:

e MM2S stands for Memory-Mapped to Streaming, whereas S2MM stands for Streaming to

Memory-Mapped.

e When Scatter-Gather is used, there is an extra AXI bus between the DMA and the memory

controller. It was left out of the diagram for simplicity.

e We’'ll start this tutorial with the base system project for the MiniZed that you’ve created in

project lecture 2.

PART 1 — Setting up the DMA communication hardware platform

1, Add the AXI DMA

1. Open the base project in Vivado.
2. Inthe Flow Nagigator, click “Open Block Design”.

W

IP INTEGRATOR

Create Block Design

Open Block Design

Generate Block Design

3. The block diagram should open, and you should only have the Zynq PS in the design.

4. Make sure that the Zyng PS has master GPO enabled.

sian L

#  Re-customize IP

ZYNQ7 Processing System (5.5)

© Documentation  %¥ Presets

Page Navigator

Zynq Block Design

PS-PL Configuration

Peripheral 1/0 Pins

MIQ Configuration

Clock Configuration

DDR Configuration

SMC Timing Calculation

Interrupts

IP Location % Import XPS Settings

PS-PL Configuration

Search: @
Name
General
AXI Non Secure Enablement
GP Master AXI Interface
M AXI GPO interface
M AXI GP1 interface
GP Slave AXl Interface
HP Slave AXI Interface
ACP Slave AXl Interface
DMA Controller
PS-PL Cross Trigger interface

Select

Description

Enable AXI Non Secure Transaction

Enables General purpose AXI master interface O

Enables General purpose AX| master interface 1

Enables PL cross trigger signals to PS and vice-versa

5. Connect the M_AXI_GPO_ACLK to the FCLK_CLKO pin, which will be the driving clock of the

master GPO interface.
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processing_system7_0

| GPO_ACLK ZYNQ‘

FOLK_CLKT
FCLK_RESETO_N

Z¥YNQ7T Processing System

GPI0.0 +|||
DDR + |||===[> DDR
FIXED_IO + || FIXED 10
uART.0 +||| -

Connect fi
to 'FCLK_

6. Click the “Add IP” icon and double click “AXI Direct Memory Access” from the catalog.

Search: < axi direct (4 matches)

T AXI Central Direct Memory Access

T AXI Direct Memory Access

T AXI Multi Channel Direct Memory Access
T AXl Video Direct Memory Access

ENTER to select, ESC to cancel, Ctrl+Q for IP details

7. The DMA block should appear and designer assistance should be available. Click the “Run
Connection Automation” link and select /axi_dma_0/S_AXI_LITE from the drop-down

menu.
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# Run Connection Automation

Automatically make connections in your design by checking the boxes of the interfaces to connect. Select an interface on the left to display its configuration
options on the right.

Description

¥ All Automation (1 out of 1 selected)
- Connect Slave interface (/axi_dma_0/S_AXI_LITE) to a selected Master address space.
) ¥ axi_dma 0

- S_AXILITE Options

Master
Bridge IP

Clock source for driving Interconnect IP | Auta
Clock source for Master interface 50 MHz

Clock source for Slave interface Autor

x processing system7_0

o0 +||
oo + | oot
FXED 10 + ||jmeee > FiXED 1O

uart0 -+ |||
e +]
soi00 -+ ||
usaiNDo + |||
M_AXILGPO +

FELK CLKD
FOLKCLKT =
FCLK_RESETON @
ZYNQT Processing System

axi_dma_0

M_AXIGPO_ACLE ZYNQ‘

M_AX| SG 4 [i

A MIM2S
WLAXIS2MM 4 |2
MLAXIS MMZS + £
M_AXIS CNTRL +
run2s_prmey_reset out

+
=+ SAXS SZMM
+ S_AXIS_STS
s_axi_te_aclk
m_ai_sg_aclk

mm2s_cntil_reset_oud_n
m_axi_mm2s_aclk o

s2mm_prmey_reset_oun
s2mm sts_reset_out n
mmas_introut

m_axi_s2mem_aclk

axi_resetn

smm_introut

AXI Direct Memory Access

Click “OK” in the window that appears. Vivado will connect the AXI-lite bus of the DMA to
the General Purpose AXI Interconnect of the PS. Your block diagram should now look like the

following.

ps7_0_axi_periph

o £+ S00_AXI
ACLK

ARESETN .Y.

so0ACk WM MO0AXI i

rst_ps7_0_50M

SOO_ARESETN g2
MOO_ACLK
MOO_ARESETN

slowest_sync_clk mb_reset
bus_struct_reset [0:0]
peripheral_reset[0:0]
interconnect_aresetn[0:0]

peripheral_aresetn[0:0] |,

ext_reset_in
«© aux_reset_in
= mb_debug_sys_rst

AXI Interconnect
= dcm_locked

| I | ll:l:ll:l:l:

Sl S AXILLITE

Processor System Reset

processing_system7_0

GPIOD +
DDR +

axi_dma_0

M_AXISG + |
M_AXI_MM25 + |
M_AXIS2MM |

WM_AXIS_ MM2S | |2
M_AXIS CNTRL —+ £
mm2s_prmry_reset_out_n
mm2s_cntrl_reset_out_n
m_axi_mm2s_aclk - - -7
X sZmm_prmiry_reset_out_n
m_axi_sZmm_aclk
h sZmm_sts_reset_out_n
axi_resetn
mm32s_introut

+ S_AXIS_SZMM
+ S_AXIS_STS
s_ani_lite_aclk

m_axi_sg_aclk

s2mm_introut

AX| Direct Memory Access

D> oor

M_AXI GPO ACLK ZYNO‘

M_AXI_GPO - e
FCLK CLKO
FCLK_CLKT

FCLK_RESETON

ZYNQ7 Processing System

2, Connect memory controller to the DMA
Now we need to connect AXI buses M_AXI_SG, M_AXI_MM2S and M_AXI_S2MM of the
DMA to a high performance AXI slave interface on the PS. Our PS doesn’t seem to have a
high-performance AXI slave interface, so we need to change the Zynq configuration to

1.

enable one. Double click on the Zynq block.

[ fxEDIO
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| 4 Re-customize 1P

ZYNQ7 Processing System (5.5)

© Documentation & Presets

IP Location & Import XPS Settings

Page Navigator 2yna Block Design Summary Report
|
Zynq Block Design
P5-PL Configuration Application Processor Unit (APU)
| Peripheral 10 Pins
ARM Cortex A9
MIO Configuration i |
Clock Configuration :
— !
| DDR Configuration oic :l Shoop | ;::
1 512 KB L2 Cache and Controller I Ports.
SMC Timing Calculation |
oom lm )
Interrupts Interconnect | SRAM
|
Memory Interfaces =
Programmable DDR233, il
Sz, [T e |
Interconnect
Processing System(PS)
e
‘l'g Performamoe XADC
Ports
Programmable Logic(PL)

2. Select “PS-PL Configuration”, open the “HP Slave AXI Interface” branch and tick the “S AXI

HPO interface” to enable it. Then click OK.

| 4 Re-customize IP

ZYNQ7 Processing System (5.5)

@ Documentation & Presets

IP Location & Import XPS Settings

Summary Report

Zyng Block Design

PS-PL Configuration Search:
Name Select Description
Peripheral 170 Pins
| > General
MID Canfiguratian > AXI Non Secure Enablement 0~ | Enable AXI Non Secure Transaction
P S f
| Clack Configuration ? G Slave Al imerface
 HP Slave AXI Interface
| DDR Configuration > 5 AXI HPD interface

SMC Timing Calculation

Interrupts

> 5 AXI HP1 interface

> 5 AXI HP2 interface

> 5 AXI HP3 interface
ACP Slave AX] Interface
DMA Controller

PS-PL Cross Trigger interface

Enables AXI high performance slave imerface 0
O

Tk sl aformance slave interface 1
PCW USE 5 AXI HPO
enaures runrmyn werformance slave interface 2

0O Enables AXI high performance slave interface 3

() Enables PL cross rigger signals to PS and vice-versa

3. The high-performance AXI slave ports should now be visible in the block diagram, and
designer assistance should be available. Click the “Run Connection Automation” link and
select /processing_system7_0/S_AXI_HPO from the drop-down menu. Click “OK”.
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G 510 DSoN - ceson.1*

ic ¢ Run Connection Automation X
| 200
Automatically make connections in your design by checking the boxes of the interfaces to connect. Select an interface on the left to display its N = * C o &
.| configuration options on the right. ’ .
. i
L Q = 2
E Description
~ (¥ All Automation (1 out of 1 selected
@ on ) Connect Slave interface (/processing_system?_0/S_AXI_HPO) ta a selected Master address
I ~ ¥ ¥ processing system7_0 space.
() & 5.1 HPO
E
Options.
e
a Master Jaxi_dma_0/M_AXIMM2S  ~
Bridge IP Auto ~
Al
Clock source far driving Intercannect IP | Auta
n
Clock source far Master interface Auto
NA Clock source for Slave interface Auto
it
1§} < >
1@ o]
| i dma 0
MENTATION ' ' l 7.0.50M
1 Implementation
sen Implemented Design
AXI Interconnect
1AM AND DEBUG
nerate Bitstream Pracessor System Reset
processing_system?_0
sen Hardware Manager
o0, AX| Direct Memory Access
Block Interface Properties ? 00X nu_:+ r~{> ooR
& 5.0 10 - » FxiD.10 D fxeoJo
[—— LT
Name: S_AXLHPO pals NG s+
- USBIND O + |
Made: SLAVE M GPD 4|
Connection Unconnected FCLK €L
FCLKCLKT
Associated clock | = 5_AXI_HPO_ACLK FCLK_RESETO.N )

ZVNQT Processing System

4. Designer assistance should again be available, click the “Run Connection Automation” link
and select /axi_dma_0/M_AXI_SG from the drop-down menu. Click “OK”.

p<7_0_axi_periph
<o ) ax_dma 0
o
SOD_ACLK = [+ SAXILTE
"

AXI Intercannect

m i mm2s aclk
= i a2mem_aclk
v resetn

X1 Direct Memory Access

Frm2s_prmey_reset_out_n O
mm2s_entr_teset_out.n B
s2mm,_prmry_roset_out_n O

AXI SmartConnect

processing system? 0

[+ 5. 1p0 FiF0 CTRL
Faglend

Z¥YNQT Processing System

1st_ps?_0_50M
3 4 P et summanon
showest sync_clk ib_reset .
it resatin s stnuct reset(00] Contgieaton s cn e gL
aux_reset in pevipharal reset|0:0]
mb_debug sys st intereannect aresetn((:0] a x e
dem locked peripheral_aresetn[00] Fr— .
W it :
Processor System Reset s v e e e
opsons

o
Bidge P

Clock s for g eerconre B

Clock s b Maer maracs | Aune

[ —— T L]
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5. Designer assistance should still be available, click the “Run Connection Automation” link and
select /axi_dma_0/M_AXI_S2MM from the drop-down menu. Click “OK”".

ps7.0_axi_periph processing_system?_0

i GRiOE
-l axi_dma 0 +li ooR
—— ack axi_smc ook +[—
|| smssern 00,10 +|[———D> FIXEDIO
o L S+ sooan uskro +|
rst_ps7_0_50M F—smpcx ma woosx + i Hisywar [I}+ s.xx_1eo ro_cTaL wco +|
b sooaresere W i AN uXa oo i+ 5.AXLHRO = o
B ] & e Bl ZYnd s00.0 +]|
west sy clk MO0 ACIK M_AX GPOACLK ]
et resetn b oo anesem S ARLHPO_ACLK o+
e it mmas_prmry coset aut.n O wAKLGo +
e A ercomnert s et o1 - i SmariConect e
ot e SEmp st ot FCLKCLEY =
<2 e FCLK RESETON B
Processor System Reset
ZVNGT Processing System

AXI Direct Memory Access

6. Now all the memory mapped AXI buses are connected to the DMA. Now we only must
connect the AXI streaming buses to our loopback FIFO and connect the DMA interrupts.

3, Add the FIFO
1. Click the “Add IP” icon and double click “AX14-Stream Data FIFO” from the catalog.

Search: < axi4 (14 matches)

¥ AXI4-Stream Accelerator Adapter
T AXI4-Stream Broadcaster

¥ AXI4-stream Clock Converter

¥ AXH4-Stream Combiner

T AXI4-Stream Data FIFO

& AXI4-Stream Data Width Converter
T AXI4-Stream Interconnect

T AXI4-Stream Protocol Checker

" AXI4-Stream Register Slice

T AXI4-Stream Subset Converter

& AXI4-Stream Switch

T AXI4-Stream to Video Out

¥ AXI4-Stream Verification IP

T Video In to AXI4-Stream

ENTER to select, ESC to cancel, Ctrl+Q for IP details

2. The FIFO should be visible in the block diagram. Now we must connect the AXI-streaming
buses to those of the DMA. Click the S_AXIS port on the FIFO and connect it to the
M_AXIS_MM2S port of the DMA.
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axis_data_fifo_0

d\s_axis_aresetn

M_AXIS + =

¢-Stream Data FIFO

M_AX|_!

" M_AXI_MM2S
— 5 AXILITE "

24 S AXIS_S2MM “rs v
M_AKIS MM2S 4 B
=4 5 AXIS_STS

v
IV CMTRL 5
s_axi_lite_aclk - i

mm2dprmiry [reset_out_n
mm2s_cntrl reset_out_n
<2mm,_prmry Yesetom
s2mm_sts_reset_out_n

mm2s_introut

m_axi_sg_aclk

m_axi_mm2s_aclk

m_axi_s2mm aclk
axi_resetn

h Y

sZmm_introut

AX| Direct Memory Access

—_I

3. Then connect the M_AXIS port on the FIFO and connect it to the S_AXIS_S2MM port of the
DMA.

axis_data_fifo_0

=+ S_AXIS
g s axis_aresetn M_AXIS - Fp
s _axis_aclk

AXI4-Stream Data Fl

axi_dma_0

M_AKISG + |3
M_AX MM2S - |t
M_AXI_S2MM - |5

A S AXLTE

H 4 s_ax1s_s2mm
=+ SAXIS_STS Connect from 'M_AXIS' interface
sadilteack 4o AXIS_SZMM interface

m_axi_sg_aclk

mm2s_cntrl_reset_out_n
sZmm_prmry_reset_out_n
s2mm_sts_reset_out_n
mm2s_introut

m_axi_mm2s_aclk

m_axi_s2mm_aclk
axi_resetn

s2mm_introut

AX| Direct Memory Access

4. Now we must connect the FIFO clock and reset. Click the s_axis_aresetn port of the FIFO
and connect it to the axi_resetn port of the DMA.
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axis_data_fifo_0

=+ S_AXIS
5_axis_aresetn

5_axis_aclk

AXI4-Stream Data FIFO

M_AXIS +

axi_dma_0

-+ JE_AXI_LITE

= — 5 AXIS_SZMM
s_axis_s2mm_tdata[31:0]
s_axis_s2mm_tkeep[3:0]

s_axis_s2mm_tlast
« s_axis_s2mm_tready
P s axis s2mm_tvalid
S_AXIS_STS

5 axi_lite_aclk
m_axi_sg_aclk
m_axi_mm2s_aclk
m_axi_sZmm_aclk
axi_resetn

M_AXIS_MM2S - =
M_AXIS_CNTRL + =
mm2s_prmry_reset_out_n
mm2s_cntrl_reset_out_n
s2mm_prmry_reset_out_n
s2mm_sts_reset_out_n
mm2s_introut

s2mm_introut

Connect from 's_axis_aresetn’ port J'
to 'rst_ps7_0_50M_peripheral_aresetn’ net .|

S_AXIS

s_axis_aresetn

s_axis_aclk

axis_data_fifo_0

M_AXIS + =

AXI4-5tream Data FIFQ

L/

P s axis_ s2mm_tlast

o s_axis_s2mm_tready

B s_axis_s2mm_tvalid
+ S_AXIS_STS

s axi_lite aclk

m_axi

m_axi

axi_resetn

I axi_dma_0

S_AXI_LITE

S_AXIS_SZMM M_AXI_SG +
P s_axis_s2mm_tdata[310] M_AXI_MM2S
P s_axis_s2mm_tkeep[3:0] M_AX_S2ZMM +

M_AXIS CNTRL +
mma2s_prmry_reset_out_n
mma2s_cntrl_reset_out_n
s2mm ormirv reset out n

m_axi Connect from 's_axis_aclk' port
to 'processing_system7_0_FCLK_CLKO' net

J

AX| Direct Memory Access

5. Click the s_axis_aclk port of the FIFO and connect it to the s_axi_lite_aclk port of the DMA.
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6. Inour design, we won’t need

the AXI-Streaming status and control ports which are used to

transmit extra information alongside the data stream. You might use them if you were
connecting to the AXI Ethernet core or a custom IP that made use of them. In the block

diagram, double click the AXI
option and click OK.

# Re-customize IP
AXI Direct Memory Access (7.1)
© Documentation

1P Location

Show disabled ports

o4 SAXLUTE
E4 SANSS2MM
- s_ai_lite_aclk
— m_ad_sg aclk
= m_ad_mm2s_aclk

MAXLS2MM {7
M_AXIS MM2S 4 =
mm2s_pimry_resetoutn O
s2mm_prmry_reset outn ©
mm2s intiout =
S2mm_introut =

a0 dma tstec310]

- m_axi_s2mm_aclk
© @i_resem

DMA block. Un-tick the “Enable Control / Status Stream”

Component Name axi_dma_0

/) Enable Scatter Gather Engine
Enable Micro DMA
Enable Multi Channel Support
Enable Control / Status Stream
Width of Buffer Length Register (8-26) 14
Address Width (32-64) |32

bits

) Enable Read Channel ) Enable Write Channel

Number of Channels 1 Number of Channels 1
Memory Map Data Width 32 v [T ] Memory Map Data Width 32
Stream Data Width 2 v Stream Data Width (Auto) 2
Max Burst Size 16 v Max Burst Size 16 v

Allow Unaligned Transfers Allow Unaligned Transfers

)

Cancel

4, Enable interrupt from the DMA
Our software application will test the DMA in polling mode, but to be able to use it in interrupt
mode, we need to connect the interrupts mma2s_introut and s2mm_introut to the Zynqg PS.

1.
Interrupts tab.

05 dacinn 1 eet ne? 0 SOM N (dacinn

#  Re-customize IP
ZYNQT Processing System (5.5)

@ Documentation & Presets IP Location & Import XPS Settings

Page Navigator - Interrupts.
Zyng Block Design «ll@ z| s
PS-PL Configuration Search: ©
1
Interrupt Port (]

Peripheral 1/O Pins
| Fabric Interrupts

MIO PL-PS Interrupt Ports

' IRQ_F2P(15:0] [91:84], [68:61]

| Clock Configuration o0 .
IR 31

DDR Configuration Core0_niRQ
| CorelnFiQ )
| SMC Timing Calculation Corel_niRQ 3

PS-PL Intermupt Ports

! | Interrupts

First, we must enable interrupts from the PL. Double click the Zynq block and select the

Summary Report

Description
Enable PL Interrupts to PS and vice versa

Enables 16-bit shared interrupt port from the PL MSB is .
Enables fast private interrupt signal for CPUO from the PL
Enables private interrupt signal for CPUD from the PL
Enables fast private interrupt signal for CPUT from the PL
Enables private interrupt signal for CPUT from the PL

2. Tick “Fabric Interrupts” and IRQ_F2P[15:0] to enable them, and click OK.
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3. Click the “Add IP” icon and double-click “Concat” from the catalog.

Search: 2 concat

1 Concat

(1 match)

4. Connect the dout port of the Concat to the IRQ_F2P port of the Zynq PS.

xlconcat 0

In0[0:0]

1001 dout]1:0]

Concat

axi_smc

{4 soo_axi
so1ax E—H
X

adk

aresetn

{4 S02.A00 WM MOOAX) - [t

\!

processing_system7_0

GPI0.0 +|||

AX| SmartConnect

008+ [}y
FIXED_IO =+ ||}

+ S_AXI_HPO_FIFO_CTRL UART_0 +|||

+ S_AXI_HPO - o +|||

M_AXI_GPO_ACLK ZYNQ SDIO.0 + |||

S_AXI_HPO_ACLK : USBIND_O =+ |||

IRQ_F2P[0:0] M_AXIGPO - [if

FCLK_CLKO

Connect from "dout’ port to IRQ_F2P' port ~

ZYNQ7 Processing System

5. Connect the mm2s_introut port of the DMA to the In0 port of the Concat.

xlconcat_0

1n0[0:0]

InE:0] Connect from
to 'In0" port

C

axi_dma_0 /
ta[310] M_AX| SG
ep3:0] M_AXI_ MM25
adk Fay
it M_AXI_S2MM Lol
} aresetn
ady M_AXIS_ MM2S +
lid mm2s_pimry_reset_out_n P= AXI SmartConnedt
S2mm_prmry_reset out n Q=
mm2s_introut
s2mm_introut =

rect Memory Access
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Connect the s2mm_introut port of the DMA to the Inl port of the Concat.

xlconcat 0

1n0[0:0]
In1[0:0]

S 1o In1" port

dout[1:0]

Connect from 's2mm_introut’ port

axi_dma_0 i sme
+ SO0_AXI T SAXLH
310 M_AXISG + i d ip S .7. + SAXIH
Ay L i / + 50200 WS MOOAX - |jimed Ll
pB:0] M_AXILMM2S =+ [} / F_ T aXa : M_AXI_GPO.
] M_AXIS2MM + ¢ a L= S_AXI_HPO,
b +; i aresetn -
dy M_AXIS_MMZS - IRQ_F2P[0:0]
d mm2s_prmry_reset_out.n = AXI SmartConnect
S2MM_prmry_reset_outn =
mm2s_introut
s2mm_introut -l

ect Memory Access

6, Validate and build the design
From the menu select Tools->Validate Design.

1.

¢ ps_pl_com - [E/VivadoProject/ASPLOC/ps_pl_com/ps_pl_com.xpr] - Vivado 2018.3

File

R

Edit Flow

Flow Navigator

v PROJECT MANAGER

Tools

Reparts  Window

Layout

View Help

[ Validate Design

Create and Package New IP...

Create Interface Definition...

F6 F

- Quick Access

2. You should get this message saying that validation was successful.

¢ Validate Design

3. Our block diagram now looks like this.

o Validation successful. There are no errors or critical warnings in this design.
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MAXSG + =t
1AL NMZS

ais_data_fifa0 axl dma 0 processing system?_0
T4 sans o a5 arog +]
— | — ook [T POR

stn M_AXIS o E
5 }E FHEDIO + |[l———D> FIXED IO
[+ s e nro cra IART &
Stre! 0 H+ saupeo

A Data FIF M_A_S2MIN waa0_a i
W_AIS MES. 2] M_AXLGPI_ACLS ZYNG™
S A1_HEDACLK
ROy _F2PI10]
FOLK U (=
FCLKRESETDN -
2ZYNQT Processing System

psT. A
SLpsT.0.50M _ peroaperph
)

n
s i
n Mo+

4. Inthe Flow Navigator, click “Generate Bitstream”. It may take a few minutes to generate the
bit stream. Below is the LUT utilization overview for the above design. Lightblue boxes
indicate busy LUTs while dark ones the free LUTs, which you can use to implement your own

design.
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PART 2 — Programming the DMA system using C

1, Export the hardware design to SDK

Once the bitstream has been generated, we can export our design to SDK where we can develop the
software application that will setup a DMA transfer, wait for completion and then verify the
loopback.

1. In Vivado, from the File menu, select “Export->Export hardware”.

Import ’
Export Export Hardware...
Launch SDK Export Constraints...
Print... Export Phlocks...
' Exit Export IBIS Model...
1 Export I/O Ports...
Export Bitstream File...
¥ RTLANALYSIS Export Simulation...

2. Inthe window that appears, tick “Include bitstream” and click “OK”.

¢ Export Hardware X

Export hardware platform for software
development tools. '

Include bitstream

Exportto: = <Local to Project= hd

)
o
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3. Again, from the File menu, select “Launch SDK”.
4. Inthe window that appears, use the following settings, and click “OK”.

¢ Launch SDK X

Launch software development tool. '

Exported location: = <Local to Project= v

Workspace: » <Local to Project> v

_
@

Text Editor *
Import »

[?5 Project Explorer 2
« (¥ design_1_wrapper_hw_platform_0
=l design_1_wrapper.bit
[& ps7_init_gpl.c
ps7_init_gpl.h
[& ps7_init.c
ps7_inith
@ ps7_inithtml
= ps7_inittcl

|5% system.hdf

5. At this point, the SDK loads and a hardware platform specification will be created for your
design. You should be able to see the hardware specification in the Project Explorer of SDK
as shown in the image below.

6. We are now ready to create the software application.

2, Create a software application
1. At this point, your SDK window should look somewhat like this:
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. ps_pl_com.sdk - C/C++ - design_1_wrapper_hw_platform_0/system.hdf - Xilinx SDK
File Edit Navigate Search Project Run Xilink Window Help
SrEl@®~-S&~ittvOovinininpm

AL RN FoR 4

{25 Project Explorer 5 B¥ ¥ O [gsystemhdf
~ (B design_1_wrapper_hw_platform_0

2 design.1_wrapperbit design_1_wrapper_hw_platform_0 Hardware Platform Specification

@ ps7.init gplc Design Information

ps7_init_gplh _

[@ ps7_initc Target FPGA Device: 7z007s

pST_inith Part: xc72007sclg225-1

@ DST_IniI html Created With: Vivado 20183

B psTimiltcl Created On:  Fri Nov 26 13:45:01 2021
[ system.hdf

Address Map for processor ps7_cortexad_0

Cell Base Addr High Addr Slave I/f Mem/Reg
ps7_intc_dist 0 0xf8f01000 Oxf8fO1fff REGISTER
ps7_gpio_0 0xe000a000  Oxe000afff REGISTER
ps7_scutimer_0 0xf8f00600 0xf8f0061f REGISTER
ps7_sler 0 0xf8000000  Oxf8000Fff REGISTER
ps7_scuwdt_0 0xf8f00620 0xf8f006ff REGISTER
ps7_l2cachec 0 0xf8f02000 Oxf8fo2fff REGISTER
ps7_scuc 0 0xf8f00000  0xf8f000fc REGISTER
ps7_qgspi_linear_0 0xfcO00000  OxFcffffff FLASH
ps7_pmu_0 0xf8893000  0xf8893fff REGISTER
ps7_afi_1 0xf8009000  OxfBO09fTT REGISTER
ps7_afi_0 0xf8008000  0xf8008fff REGISTER
ps7_gspi_0 0xe000d000  Oxe000dfff REGISTER
ps7_usb_0 0xe0002000  Oxe0002fff REGISTER
ps7_afi 3 0xf800L000  Oxf8QObFff REGISTER
ps7_afi_2 0xf800a000  Oxf800afff REGISTER
ps7_globaltimer_0 0xf8f00200 0xf8f0021f REGISTER
ps7_dma_s 0xf8003000  OxfBO03ffT REGISTER
ps7_iop_bus_config_0 0xe0200000  Oxe0200fff REGISTER
ps7_xadc_0 0xf8007100  Oxf8007120 REGISTER
ps7_ddr 0 0x00100000 OxTFFFFAT MEMORY
ps7_ddrc 0 0xf8006000  Oxf800GFff REGISTER
ps7_ocmc_0 0xf800c000 0xf800cfff REGISTER
ps7_pl310_0 0xf8f02000 Oxf8fo2fff REGISTER
axi_dma_0 0x40400000  Ox4040ffff S_AXILITE REGISTER
ps7_uart_1 0xe0001000  OxeQOO1fff REGISTER
ps7_coresight_comp_0 0xf8800000 OxfBEFFf REGISTER
ps7_uart_0 0xe0000000  Oxe0000fFf REGISTER
ps7.i2c 0 0xe0004000  OxeQ004fff REGISTER
ps7_scugic_0 0xf8f00100 0xf8f001f REGISTER
ps7_dev_cfg 0 0xf8007000  0xf80070ff REGISTER
ps7_dma_ns 0xf38004000  Oxf8004fff REGISTER
ps7_sd_1 0xe0101000  Oxe0101fff REGISTER
ps7_sd_0 0xe0100000  Oxe0100fff REGISTER
ps7_gpv 0 0xf8900000 OxFBYFFfT REGISTER
psT_ram_1 0xffffO000 Oxfffffdff MEMORY
ps7_ram_0 0x00000000  0x0002ffff MEMORY

IP blocks present in the design

ps7_0_axi_periph axi_interconnect 21

ps7_intc_dist 0 ps7_intc_dist 1.00.a

axi_dma_0 axi_dma 7.1 Registers

ps7_gpio_0 ps7_gpio 1.00.a

axis_data_fifo_0 axis_data_fifo 20

ps7_scutimer_0 ps7_scutimer 1.00.a

ps7_sler 0 ps7_slcr 1.00a

ps7_scuwdt_0 ps7_scuwdt 1.00.a

ps7_12cachec_0 ps7_l2cachec

= 0

2. To make things easy for us, we’ll use the template for the hello world application and then

modify it to test the AXI DMA. From the File menu, select New->Application Project.

n ps_pl_com.sdk - C/C++ - design_1_wrapper_hw_platform_0/system.hdf - Xilinx SDK

File Edit MNavigate Search Project Run Xilinx Window Help
N Alt+Shift+N lication Project
Open File... Ed SPM Project
. Open Projects from File System... W Board Support Package
Close craw | O Project- 2o

3. Inthe first page of the New Project wizard, choose a name for the application. I've chosen

hello_world. Click “Next”.
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Bl New Project O x

Application Project &
Create a managed make application project.

Project name: hello_world|

B Use default location

Location: | E\VivadoProject\ASPLOC\ps_pl com\ps_pl com.sdk\hello world Browse...

Choose file system: default ~

OS Platform: standalone

-
Target Hardware
Hardware Platform: design_1_wrapper_hw_platform_0 v Nﬂ
Processor: ps/_cortexa9 0 ~
Target Software
Language: Oc OcC++
Compiler: 32-bit ~
Hypervisor Guest: N/A ~
Board Support Package: o Create New  hello_world_bsp

Use existing ~

4. Onthe templates page, select “Hello World” template and click “Finish”.

BB New Project [m] X
Templates .@
Create one of the available templates to generate a fully-functioning application
project.

Available Templates:

Dhrystone Let's say 'Hello World' in C. a
Empty Application

IwlIP Echo Server

IwIP TCP Perf Client

IwIP TCP Perf Server

IwIP UDP Perf Client

IwlP UDP Perf Server

Memory Tests

OpenAMP echo-test

OpenAMP matrix multiplication Demo
OpenAMP RPC Demo

Peripheral Tests

RSA Authentication App

Zyng DRAM tests

Zynq FSBL

Next > Einish Cancel
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5. The SDK will generate a new application which you should find in the Project Explorer as in

the image below.

[?5 Project Explorer &2

E%‘v v = H

v (#F design_1_wrapper_hw_platform_0

= design_1_wrapper.bit
[@ ps7_init_gpl.c
ps7_init_gpl.h

@ ps/_init.c

ps7_inith

@ ps7_inithtml
s7_init.tcl

v L"?‘Hello,world
> ¥ Binaries
> [ Includes
> = Debug
v [= sIC

> [2 helloworld.c
> [ platform_config.h
> [g platform.c
> [ platform.h
& Iscriptld
= Xilinx.spec
> (B hello_world_bsp

The hello_world folder contains the Hello World software application, which we will modify

to test our AXI DMA.

3, Modify the software application
We need to modify the hello world software application to test our DMA. The application source
code we are using in this tutorial is one of the many valuable examples provided by Xilinx in the
installation files. If you didn’t know about those examples, | suggest you check it out every time you
start playing with a new IP core.

1.

From the Project Explorer, open the hello_world/src folder. Open the “helloworld.c” source

file.

Replace all the code in this file with the code that you will find in the Vivado example project

for AXI DMA.

Peripheral Drivers

Drivers present in the Bea

axi_dma_0 axidma
psT_afi-B-generic.
ps7_afi_1 generic
ps7_afi_2 generic
ps7_afi_3 generic

ps7_coresight_comp_0 coresightps_dcc Documentation

ps7_ddr_0 ddrps.
ps7_ddrc_0 generic
ps7_dev_cfg_0 devcfg
ps7_dma_ns dmaps
ps7_dma_s dmaps
ps7_globaltimer_0 generic
ps7_gpio_0 gpiops
ps7_gpv_0 generic

ps7_i2c_0 iicps

ps7_intc_dist_0 generic
ps7_iop_bus_config_0 generic
ps7_l2cachec_0 generic
ps7_ocmc_0 generic
ps7_pl310_0 generic
ps7_pmu_0 generic
ps7_gspi_0 gspips
ps7_qspi_linear_0 generic
ps7 ram 0 generic

Documentation Import Examples

Documentation

Documentation Import Examples
Documentation Import Examples
Documentation Import Examples

Documentation Import Examples

Documentation Import Examples

Documentation Import Examples

upport Package:
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3. Copy the contents of “xaxidma_example_sg_polll.c” into “helloworld.c”.

|43 system.hdf
« 5 hello_world
> ¥ Binaries
> & Includes
> (= Debug
=
> |8 helloworld.c
[8 platform_config.h
> [8 platform.c
> [8 platform.h
& Iscriptid
|2 Xilinx.spec
~ ( hello_world_bsp
> i BSP Documentation
> (= ps7_cortexa9_0
L& Makefile
[Hh, system.mss

v & hello_world_bsp_xaxidma_example_sg_poll_1
> #% Binaries
> [ Includes
> = Debug
v [ srC
> 16l xaxidma_example_sg_poll.c

B Iscriptld

README.txt

= Xilinx.spec

4. Compile the project and launch it on the board. If everything is successful, the output
message “Successfully ran AXI DMA SG Polling Example” will appear in the com port.
5. Note that by default the “hello world” project template initiate stdin/stdout to ps7_uart_0.

ol BECREIE B 4

1 gsystemhdf [ system.mss 5 | [g helloworld.c = B Bz outline 2
nello_world_bsp Board Support Package

An outline is not a
Modify this BSP's Settings  Re-generate BSP Sources |

Target Information

EE—— | H Board Support Package Settings X
This Board Support Pac

Hardware Specificatior Board Support Package Settings &
Target Processo Control various settings of your Board Support Package.

Operating System

~ Overview ) )
Board Support Package o — Configuration for OS: standalone
Name: stand ~ drivers Name Value Default Type Description
Version: 6.8 ps7_cortexad_0 hypervisor_guest false false boolean Enable hypervisor guest si
Description: Stand lockstep_mode_debug false false boolean Enable debug logic in nor
asug sleep_time o peripheral This parameter is used to
Documentation: stand ps7_uart_0 peripheral stdin peripheral
Peripheral Drivers ps7_uart_0 peripheral stdout peripheral
e EEE—— | ttc_select_cntr 2 enum Selects the counter to be 1
Drivers present in the B zyngmp_fsbl_bsp false false boolean Disable or Enable Optimi:
axi_dma_0 ¥ microblaze_exceptions false false boolean Enable MicroBlaze Except
ps7_afi_0 » enable_sw_intrusive_profili false false boolean Enable S/W Intrusive Profi

ps7_afi_1

6. However, if we go back to Vivado and open up the Zynq7000 configuration view for
peripheral I/0O, we can see that in our system, by default, UART 0 is used for EMIO but UART
1 is used for communication port UART 1.
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Q

o m o

o |

J L oFd SPI1 SPI SPI1 EMIC

> UART 0 JARTO UARTO UARTO UARTO UARTO UARTO UARTO UARTO R

> UART 1 UART1 UART1 UART1 UART1 UART1 UART1 ‘ UART1 ‘ UART1 EMIC

7. Modify the bsp file so that stdin/stdout are pointing to UART 1 instead of UART 0.

. Board Support Package Settings b4
Board Support Package Settings *
Control various settings of your Board Support Package.
~ QOverview
standalone Configuration for OS: standzalone
~ drivers Name Value Default Type Description
ps7_cortexad_0 hypervisor_guest false false boolean Enable hypervisor guest st
lockstep_mode_debug false false boolean Enable debug logic in nor
sleep_timer none none peripheral This parameter is used to
stdin ps7_uart_1 none peripheral stdin peripheral
stdout ps7_uart_1 none peripheral stdout peripheral
ttc_select_cntr 2 2 enum Selects the counter to be |
zyngmp_fsbl_bsp false false boolean Disable or Enable Optimi:
» microblaze_exceptions false false boolean Enable MicroBlaze Except
» enable_sw_intrusive_profili false boolean Enable S5/W Intrusive Profi

8. Ater the modification you should see the output correctly in the COM port.

ps/_¥adc_U xadcps Uocumentation Import kxamples

Libraries

Libraries present in the Board Support Package.
No libraries in the Board Support Package

Overview Source|

B [fl Problems ¥ Tasks & Console [ Properties B SDK Terminal 2 =X 4L =0

Connected to: Serial { COM4, 115200, 0,8)

=~ Entering main() ---
Successfully ran AXI DMA SG Polling Example
--- Exiting main() ---

9. If you see this message, then everything should be set correctly in the whole HW/SW
platform.
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